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[bookmark: _Toc113673643][bookmark: _Toc203821467][bookmark: _Toc528946967][bookmark: _Toc528948232][bookmark: _Toc528948498]Общие сведения
[bookmark: _Toc2684309][bookmark: _Toc113673644][bookmark: _Toc203821468][bookmark: _Toc528946968]Полное наименование системы и ее условное обозначение
[bookmark: _Toc528946969]Полное наименование системы – Единый портал общественного обсуждения проектов нормативных правовых актов Кыргызской Республики.
[bookmark: _Toc528946970]Краткое наименование системы – Портал общественного обсуждения.
1. [bookmark: _Toc528946971][bookmark: _Toc2684310][bookmark: _Toc113673645][bookmark: _Toc203821469]
1.1. [bookmark: _Toc528946972]
[bookmark: _Toc528946973]1.2 Наименования разработчика и заказчика
[bookmark: _Toc528946974]1.2.1 Заказчик – ПСУ и Министерство юстиции Кыргызской Республики. Бенефициары – субъекты нормотворческой деятельности в КР.
[bookmark: _Toc528946975]1.2.2 Разработчик будет определен по результатам конкурса.
1.1 [bookmark: _Toc528946976][bookmark: _Toc2684311][bookmark: _Toc113673646][bookmark: _Toc203821470]
[bookmark: _Toc528946977]Основание для разработки
[bookmark: _Toc528946978]Основанием для разработки Единого портала общественного обсуждения проектов нормативных правовых актов является Национальный план действий по построению Открытого Правительства в Кыргызской Республике на 2018-2020 годы, утверждённый Распоряжением Правительства Кыргызской Республики от 16 октября 2018 года № 360-р. В целях повышения эффективности при подготовке проектов нормативных правовых актов, а также улучшения качества принимаемых нормативных правовых актов, принимая во внимание развитие информационных технологий в этой области, имеется целесообразность в разработке данного портала.
[bookmark: _Toc2684312][bookmark: _Toc113673647][bookmark: _Toc203821471][bookmark: _Toc528946980]Основные задачи и сроки разработки
[bookmark: _Toc528946981]Предусматривается реализация следующих задач:
· Техническое проектирование системы.
· Разработка портала.
· Тестирование.
· Презентация портала. 
· Обучение пользователей. 
· Прием и передача работ, документов, исходных кодов. 
[bookmark: _Toc528946982]Работы в рамках настоящего технического задания должны быть выполнены в течение _____________________с даты подписания контракта.





1.5	Термины, сокращения, определения
	СМЭВ «Түндүк»
	Система межведомственного электронного взаимодействия КР

	Адаптер (Веб-сервис)
	Программный компонент, обеспечивающий межсистемное взаимодействие путём предоставления пользователям (внешним системам) через программный интерфейс набора функций (методов)

	ПИН
	Персональный идентификационный номер

	Лицензия
	Набор правил, определяющих характер, способ, стоимость и иные условия использования сервисов

	КР
НПА
	Кыргызская Республика
Нормативный правовой акт

	СУБД
	Система управления базами данных

	БД
E-mail
Бан
	База данных
Электронная почта
(англ. ban, /bæn/ — запрещать, объявлять вне закона) — один из принятых способов контроля над действиями пользователей. Как правило, бан заключается в лишении или ограничении каких-либо прав пользователя (на создание/отправление новых сообщений или создание новых тем на портале, на отправление сообщений в чате, на комментирование в блогах, ограничение доступа к личным страницам и др.).

	Twitter (Твиттер)
	Социальная сеть

	Facebook (Фейсбук)
Instagram (Инстаграм)
	Социальная сеть
Cоциальная сеть 



[bookmark: _Toc113673649][bookmark: _Toc203821473][bookmark: _Toc528946983][bookmark: _Toc528948233][bookmark: _Toc528948499]Цели создания Портала общественных обсуждений
[bookmark: _Toc528946984]Основной целью создания Портала общественного обсуждения (далее по тексту – Портал или Система) является повышение эффективности общественного обсуждения проектов нормативных правовых актов через автоматизацию процессов общественного обсуждения для: 
(1)  обеспечения доступности проектов нормативных правовых актов для комментирования различными заинтересованными сторонами;
(2) улучшения обратной связи субъектов нормотворческой деятельности с лицами, давшими свои комментарии и рекомендации к проектам нормативных правовых актов;
(3) принятия более качественных решений субъектами нормотворческой деятельности с учетом общественного мнения.
[bookmark: _Toc2684321][bookmark: _Toc113673656][bookmark: _Toc203821482][bookmark: _Toc528946985]Технические и функциональные требования к Cистеме
[bookmark: _Toc528946986]Система должна быть максимально удобной в эксплуатации и иметь легкий в освоении и удобный в использовании пользовательский интерфейс.
[bookmark: _Toc528946987]Система должна быть масштабируемой.
[bookmark: _Toc528946988]Добавление новых функциональных возможностей не должно, как правило, сопровождаться изменениями в ранее разработанной и эксплуатируемой части.
[bookmark: _Toc528946989]Система должна гарантировать достаточный уровень защиты информации и надежности при эксплуатации.
[bookmark: _Toc528946990]Система должна иметь интерфейс для публикации информации.
[bookmark: _Toc528946991]Система должна обеспечивать аутентификацию пользователей по ПИН, имени и паролю.
[bookmark: _Toc528946992]Система должна предоставлять удобные средства для поиска необходимой информации.
Система должна обеспечивать кроссплатформенность и кроссбраузерность.
Система должны быть снабжена специализированным программным обеспечением – адаптером, который обеспечит конвертацию запросов, передаваемых посредством платформы «Түндүк», в формат, требуемый информационной системой участника «Түндүк», и обратно, для осуществления взаимодействия.
2.2.0	Система должна быть адаптирована для мобильных устройств (IOS, Android)
2.2.1	На основе системы должно быть создано мобильное приложение.
2.2.2	Система должна иметь фильтр нецензурных слов (кырг., русс., англ.), т.е. автоматически проверять публикацию информации пользователями, корректировать без изменения сути или отказывать в публикации при наличии нецензурных слов или выражений. (Вопрос к обсуждению: необходимо обсудить возможность корректировки отдельных сообщений, которые несут хороший смыл, но имеют нецензурные слова)

См. приложения А и Б.
[bookmark: _Toc528948234][bookmark: _Toc528948500]Структура и описание Портала

3.1 Главная публичная страница Портала (общая для всех подразделов) содержит:
· графическую часть (интегрировать в дизайн герб Кыргызской Республики);
· название Портала;
· версию для слабовидящих; 
· строку для быстрого поиска, по ключевым словам,
· меню «Расширенный поиск»;
· меню «Законопроекты»;
· меню «Подзаконные акты»;
· меню «Исполнение законов»;
· меню «Правотворческая инициатива граждан» (Электронная петиция);
· меню «Руководство пользователя»;
· навигационное меню «иконки»;
· меню «Личный кабинет»;
· меню «Архив стенограмм и аудио-видео записей»;
· навигационное меню «Подписаться на рассылку»;
· иконки социальных сетей Twitter, Instagram, Facebook;
· контентную область для того, чтобы посетитель Портала с первой страницы мог получить вводную информацию о Портале, просмотреть объявления об общественных обсуждениях;
· вывод на главную страницу иллюстрированных кратких анонсов по новым проектам нормативных правовых актов;
· графическое изображение статистических данных.
Внизу страницы:
· отображается облегченная навигационная панель в текстовом виде; 
· указывается, что все права защищены и принадлежат Министерству юстиции Кыргызской Республики; 
· указывается, что «Портал создан при поддержке Программы USAID по совместному управлению и Программы ЕС по верховенству права в Кыргызской Республике» и размещаются логотипы Министерства юстиции Кыргызской Республики, USAID, EWMI и Программы ЕС;
· размещены счетчики статистики посещения Портала.

3.2 Структура
Общее навигационное меню:
· Законопроекты
· Подзаконные акты
· Правотворческая инициатива граждан (Электронная петиция)
· Руководство пользователя
· Архив стенограмм и аудио-видео записей
· Личный кабинет
· Подписаться на рассылку
· Расширенный поиск
· Статистика
· Контакты  
· Версия для слабовидящих

Навигационное меню «иконки»:
· Главная страница
· Карта портала
· Версия страницы для печати
· Instagram, Facebook и Twitter

Меню «Контакты»:
· E-mail Администратора сайта
· E-mail, телефонные номера, WhatsApp ответственных специалистов в государственных органах

Навигационное меню «Личный кабинет»:
· Регистрация
· Войти


3.3 Описание функциональности разделов Портала
· Законопроекты – одно или многоуровневый список (при необходимости можно разделить на подразделы) в формате:
· Инициированные депутатами ЖК КР
· Инициированные Правительством КР
· Инициированные народом
Каждый законопроект сопровождается графическим изображением диаграммы статуса законопроекта, а также графическим изображением диаграммы проголосовавших за и против.

· Проекты подзаконных актов – одно или многоуровневый список (при необходимости можно разделить на подразделы) в формате:
· Президента КР
· Жогорку Кенеша КР
· Правительства КР
· Национального банка КР
· Центральной комиссии по выборам и проведению референдумов КР
· Органов местного самоуправления
Каждый подзаконный акт сопровождается графическим изображением диаграммы статуса подзаконного акта, а также графическим изображением диаграммы проголосовавших за и против.

· Правотворческая инициатива граждан (Электронная петиция)– таблица с подразделами в формате:
· Порядковый номер инициативы
· Наименование
· Дата создания
· Просмотрено
· Нравиться
· Поделиться
· История всех просмотров и комментариев:
· Порядковый номер комментария
· Дата комментария
· Комментарий 
· Нравиться 
· Поделиться 
· Архив стенограмм и аудио-видео записей - Архив стенограмм и аудио-видео записей пленарных обсуждений и комитетских слушаний.
· Подписаться на рассылку – список для выбора сферы регулирования нормативного правового акта. Обязательно наличие строки подписки по ключевому слову. При выборе происходит добавление пользователя в БД рассылки с появлением надписи «Вы успешно подписались на рассылку». Предусмотреть подписку по видам рассылки (Получение уведомлений для возможности отслеживания статуса законопроекта, новых комментариев, об окончании общественных обсуждений либо предупреждения за какое-то время до окончания обсуждений), новостная рассылка с кратким описанием по отраслям.
· Руководство пользователя – информация по использованию портала, видеоролики, НПА.
· Расширенный поиск – фильтры для уточнения результатов поиска с возможностью выбора:
· По инициатору
· По виду нормативных правовых актов
· По сферам регулирования
· По ключевым словам
· По периоду добавления
· По самым обсуждаемым
· По наиболее посещаемым
· По срокам обсуждения
· Online-комментарий – форма «комментарий» с полями:
· ФИО дающего комментарий с возможностью скрыть данные о себе
· Краткий текст комментария (при необходимости вызов полного текста, если комментарий объёмный). Комментарии кыргызской и русской версии портала должны отражаться в обоих версиях портала.
· Возможность вложения файла
· Контакты – многоуровневый раздел:
- администратор портала – список в формате:
· Электронный адрес
· Номера телефонов 
· Режим работы
· WhatsApp, Viber, Telegram
- ответственные специалисты в государственных органах – список в формате:
· Название государственного органа или должностного лица 
· Фамилия, имя, отчество
· Должность
· Электронный адрес
· Номер телефона
· Режим работы
· WhatsApp, Viber, Telegram
· Адрес
· Карта Портала – стандартный шаблон с выводом всех разделов и подразделов Портала в виде списка.
· Служебный вход для администраторов - многоуровневый раздел (возможно с подкатегориями), куда администратор может войти, используя Идентификацию пользователя/Пароль:
· Государственные органы – управление аккаунтами государственных органов
· Пользователи – управление пользователями
· Отчеты – формирование, вывод и выгрузка в pdf и xlsx форматы
· История:
· История всех просмотров и комментариев
· История всех изменений, связанных с привилегиями, предоставленными для различных пользователей администратором, а также созданием и блокировкой аккаунтов пользователей и администраторов
· Рассылка.  Возможность создания и оформления новостной рассылки с описанием по отраслям. Управление рассылками (категории, сортировка, создание\удаление подписчиков и групп подписчиков). Возможность рассылки электронных писем и WhatsApp сообщений подписчикам. Возможность выгрузки списка подписанных\отписанных подписчиков в doc, xlsx форматы.
· Выход
· Служебный вход для пользователей - многоуровневый раздел (возможно с подкатегориями), куда пользователь может войти, используя Идентификацию пользователя/Пароль:
· Проекты - просмотр, комментирование, вывод на печать и выгрузка в pdf и doc форматы.
· Правотворческая инициатива граждан.
· Подписки на рассылку – подписка\отписка на рассылку проектов НПА, наличие строки подписки по ключевому слову.
· Поддержка.
- Обратная связь
- Справка
· Отчеты – поиск, вывод на печать и выгрузка отчетов по просмотренным проектам и проектам с комментариями в pdf и doc форматы.
· Поиск с встроенными фильтрами
· Выход
· Служебный вход для государственных органов - многоуровневый раздел (возможно с подкатегориями), куда пользователь может войти, используя Идентификацию пользователя/Пароль.:
· Проекты – публикация, удаление, просмотр, комментирование, вывод на печать и выгрузка в pdf и doc форматы. Формат публикуемых проектов НПА должен быть одного стандарта (тип шрифта, размер шрифта и т.д.). 
· Публикуемые проекты законов должны содержать:
- Проект закона на государственном языке
- Справку-обоснование на государственном языке
- Сравнительную таблицу на государственном языке в случае внесения изменений
- Проект закона на официальном языке
- Справку-обоснование на официальном языке
- Сравнительную таблицу на официальном языке в случае внесения изменений
- Справку по результатам анализа регулятивного воздействия при необходимости
· Каждый отдельный вид нормативного правового акта должен содержать отдельный перечень обязательных сопроводительных документов.
· Подписки на рассылку – подписка\отписка на рассылку проектов НПА, наличие строки подписки по ключевому слову
· Рассылка. Возможность создания и оформления новостной рассылки с описанием по отраслям. Управление рассылками (категории, сортировка, создание\удаление подписчиков и групп подписчиков). Возможность рассылки электронных писем и WhatsApp сообщений подписчикам. Возможность выгрузки списка подписанных\отписанных подписчиков в doc, xlsx форматы.
· Поддержка 
- Обратная связь
- Справка
· Отчеты – поиск, вывод на печать и выгрузка отчетов по просмотренным проектам и проектам с комментариями в pdf и doc форматы
· Поиск с встроенными фильтрами
· Выход

· Версия для слабовидящих – модуль автоматической генерации версии Портала для слабовидящих с возможностью озвучивания текста на страницах Портала.
· Ссылки – технический раздел со структурированным списком ссылок и форма для обмена тематическими ресурсами.

[bookmark: _Toc203821484][bookmark: _Toc528946993][bookmark: _Toc528948235][bookmark: _Toc528948501][bookmark: _Toc203821485]4 Порядок контроля и приемки системы
[bookmark: _Toc528946994]4.1 Условия приемки работ
[bookmark: _Toc528946995]4.1.1 Приемка и оценка работ, выполненных в соответствии с настоящим техническим заданием, осуществляется комиссией, включающей представителей Заказчика и Исполнителя.
[bookmark: _Toc528946996]4.1.2 По результатам приемо-сдаточных работ оформляется Акт сдачи-приемки.
[bookmark: _Toc203821486][bookmark: _Toc528946997][bookmark: _Toc528948236][bookmark: _Toc528948502]5 Условия тестирования
[bookmark: _Toc528946998]5.1 Тестирующая группа совместно с разработчиками в соответствии с техническим заданием разрабатывают перечень тестовых критериев для проведения испытаний.
[bookmark: _Toc528946999]5.2 По завершении испытательных работ заполняется Акт проведенных испытаний, в котором дается оценка соответствия реализации к техническому заданию, ставится отметка об исполнении и приводятся рекомендации по устранению замечаний с конкретными временными сроками для исполнения.
[bookmark: _Toc528947000]5.3 По результатам тестирования разработчики на основании акта вносят изменения в систему, после чего система проходит тестирование снова.
[bookmark: _Toc528947001]5.4 Проводится обучение пользователей и ИКТ специалистов по работе с системой, оказание методической консультативной помощи.
[bookmark: _Toc528947002]5.5 При наличии замечаний и рекомендаций разработчики в ходе тестирования устраняют недостатки системы в соответствии с настоящим техническим заданием.
[bookmark: _Toc203821488][bookmark: _Toc528947003][bookmark: _Toc528948237][bookmark: _Toc528948503]6 Подготовка Системы к вводу в действие
6.1 Для обеспечения качественной разработки Системы и своевременной сдачи проекта необходимо применять итерационный подход и наметить промежуточные этапы сдачи проекта. После окончания разработки основной части проекта необходимо произвести следующие работы:
· Публикация Портала на сервере Министерства юстиции КР.
· Закупка сервера безопасности (системный блок), настройка и подключение адаптеров.
· Настройка и запуск Системы.
· Тестовые испытания.
· Подготовка документации в соответствии с перечнем, указанным в пункте 7 настоящего Технического задания.
· Обучение участников (пользователей, администраторов и ИКТ специалистов) системы.
· Сдача в опытную эксплуатацию.
[bookmark: _Toc2684332][bookmark: _Toc113673662][bookmark: _Toc203821489][bookmark: _Toc528947004][bookmark: _Toc528948238][bookmark: _Toc528948504]7 Требования к документированию
[bookmark: OLE_LINK3]7.1 В принимаемую в опытную эксплуатацию систему включается комплект документации, который должен включать:
· Техническое описание программ, включая описание функциональных модулей, взаимосвязи функциональных модулей, описание справочников и структур таблиц, ER-диаграмм и описания к ним.
· Руководство для администрирования и поддержки системы.
· Руководство пользователя системы.
[bookmark: _Toc203821490][bookmark: _Toc528947005][bookmark: _Toc528948239][bookmark: _Toc528948505]8 Гарантийное сопровождение системы
[bookmark: _Toc528947006]8.1 Гарантийное сопровождение системы осуществляется на протяжении 2 лет после сдачи системы в эксплуатацию. 
[bookmark: _Toc528947007][bookmark: _Toc528947008][bookmark: _Toc528948240]8.2 В случае обнаружения ошибок и дефектов в системе в течение гарантийного срока исполнитель обязан исправить их в соответствии с техническим заданием. 

9 [bookmark: _Toc528948506]Приложение A.  Технические и функциональные требования к системе

Участник тендера обязан детально описать процесс реализации каждого функционального требования. В случае, если у участника тендера на момент заполнения тендерных документов  нет готового решения, то необходимо указать, какие усилия будут приложены  для удовлетворения требования и любые другие открытые замечания о требованиях.


	

No.
	
Функциональные требования
	Статус
	
Примечания / ссылки на дополнительную информацию

	
	
	О или Ж

	

	1. 
	Регистрация пользователей (электронный журнал)
	
	

	1.1

	Процесс регистрации в системе происходит посредством ПИН (через Веб сервис), Google, Twitter или Facebook аккаунты.
	О
(обязательно)
	

	1.2

	Система должна иметь веб-интерфейс, куда пользователь может войти, используя Идентификацию пользователя/Пароль.
	О
(обязательно)
	

	1.3
	Данный веб-интерфейс должен иметь функцию, позволяющую пользователям выбрать тип транзакции (нравится, не нравится, просмотр, создание, изменение, обновление, удаление).
	О
(обязательно)
	

	1.4

	Основываясь на типах транзакции, выбранных пользователем, веб-интерфейс должен перейти к соответствующему окну для ввода данных пользователем. 
(Форма для ввода комментария).
	О
(обязательно)
	

	2.
	Формат публикуемых проектов НПА и вывод на экран
	
	

	2.1
	Текст должен быть набран в текстовом редакторе Microsoft Word на листе формата А-4 в соответствии с требованиями Инструкции по законодательной технике, утвержденной постановлением Жогорку Кенеша Кыргызской Республики от 26 июня 2015 года № 5389 и Инструкции по разработке проектов подзаконных актов Кыргызской Республики, утвержденной постановлением Правительства Кыргызской Республики от 31 мая 2017 года №313. 
Система должна отказывать в публикации проектов НПА при несоответствии вышеуказанному формату. 
Должна быть возможность просмотра проектов НПА без предварительного скачивания.
	О
(обязательно)
	

	3.
	Изменения и модерация
	
	

	3.1
	Веб-интерфейс должен иметь возможность внесения поправки. Только авторизованный пользователь, может вносить комментарии, лайки и т.д.
	О
(обязательно)
	

	3.2
	Возможность изменения\удаления информации (материала, комментария) имеет только создатель данного материала.
	О
(обязательно)
	

	3.3
	Администратор портала не должен иметь прав на изменение\удаление информации (материала, комментария) из системы, если он не является создателем данного материала.
	О
(обязательно)
	

	3.4
	Должна быть возможность модерации только по жалобе пользователей. Информация (материалы, комментарии, проекты НПА) будет публиковаться мгновенно без предварительной проверки модератором. Информация с нецензурными выражениями будет блокироваться системой автоматически.
	О
(обязательно)
	

	4.
	Поиск данных
	
	

	4.1
	Система должна иметь расширенную функцию поиска по дате, по данным и ключевым словам.
	О
(обязательно)
	

	4.2
	Поиск должен осуществляться типами алфавитов (русский, кыргызский)
	О
(обязательно)
	

	5.
	Создание пользователя и осуществление поддержки
	
	

	5.1
	Система должна иметь функцию создания нового логина и пароля пользователя вместе с возможностью ввода базовой информации о пользователе (электронная почта, номер телефона).
	О
(обязательно)
	

	5.2
	Система должна иметь возможность изменять данные, касающиеся пользователей, администратор также должен иметь доступ на изменение такой информации.
	О
(обязательно)
	

	5.3
	Система должна иметь функцию назначения ролей на основе авторизации.
	О
(обязательно)
	

	5.4
	Система должна иметь функцию создания администратора для каждого зарегистрированного офиса, который будет устанавливать/изменять привилегии пользователей, связанных с данным офисом.
	О
(обязательно)
	

	5.5
	Система должна иметь функцию, предоставляющей авторизованному персоналу, обновлять, добавлять, отменять пароли пользователей по запросу.
Необходимо предусмотреть, что при неправильном вводе пароля 3 раза система должна автоматически заблокировать. При этом, система одновременно должна направить администратору уведомление в какое время произошла попытка доступа и через какой логин.
	О
(обязательно)
	

	5.6
	Владелец системы не имеет права удалять пользователей, но он имеет права на бан пользователя. При бане пользователя все его материалы, комментарии, лайки и просмотры должны оставаться в БД. При открытии учетной записи пароль может быть обновлен самим пользователем.
	О
(обязательно)
	

	5.7
	Владелец системы будет иметь возможность для создания администраторов для групп пользователей, которые могут создавать зависимых пользователей.
	О
(обязательно)
	

	5.8
	Система должна предоставлять возможность создания и поддержки групп пользователей и управление правами доступа.
	Ж
(желательно)
	

	5.9
	Система должна иметь функцию рассылки электронных писем всем пользователям одновременно, группе пользователей, группе администраторов, выборочно одному пользователю, а также выборочно нескольким пользователям.
	О
(обязательно)
	

	6.
	Аудит
	
	

	6.1
	Система должна поддерживать аудит всех изменений данных (кто, когда и какие данные вводил).
	О
(обязательно)
	

	6.2
	Система должна поддерживать аудит всех изменений, связанных с привилегиями, предоставленными для различных пользователей администратором, а также созданием и блокировкой аккаунтов пользователей и администраторов.
	О
(обязательно)
	

	7.
	Отчетность для пользователей системы и администраторов
	
	

	7.1
	Система должна поддерживать вывод отчетов аудита всех изменений данных.
	О
(обязательно)
	

	7.2
	Вывод отчетов – анализ в виде диаграммы, графика и таблицы по заданным периодам (годы, год, месяц, неделя, произвольный период), сводные отчеты, отчеты по категориям.
	О
(обязательно)
	

	7.3
	Система должна выводить статистические отчеты по количеству комментариев, оставленных без ответа и получивших ответы с нарушением сроков в разрезе государственных органов
	
	

	7.4
	Возможность преобразования и выгрузки отчетов в форматы pdf, xlsx, doc.
	О
(обязательно)
	

	7.5
	Отчет должен поддерживать интерфейс и ввод на кыргызском и русском языках
	О
(обязательно)
	

	8.
	Веб-портал
	
	

	8.1
	Дизайн, реализация и обслуживание веб-портала для общего просмотра и доступа к данным, и вход для авторизированных пользователей, и обеспечение доступа. Портал будет связан с системой управления контента, поставщик должен будет предоставить как минимум три варианта графического интерфейса для выбора. Точка входа должна следовать дизайну и функциям веб-портала, который позволит вносить информацию из различных источников в едином порядке. Кроме того, веб-портал обязательно должен содержать API и функции для интеграции социальных медиа (Facebook, Twitter и др.).
	О
(обязательно)
	

	8.2
	Предлагаемое решение должно быть разработано в конфигурации общего доступа. Этот публичный доступ должен быть единой точкой для зарегистрированных и не зарегистрированных пользователей. 
	О
(обязательно)
	

	8.3
	Веб-портал обязан быть в многоязычном режиме, на кыргызском и русском языках.
	О
(обязательно)
	

	9.
	ИТ-поддержка
	
	

	9.1
	Поставщик должен обеспечить систему отслеживания сбоев (также систему тикетирования, систему обслуживания тикетов, управление запросами или систему открытых инцидентов), чтобы управлять и отслеживать списки проблем.
	Ж
(желательно)
	

	9.2
	Поставщик должен обеспечить гарантию и поддержку приложения длительностью двадцать четыре (24) месяца
	О
(обязательно)
	

	9.3
	Обеспечение резервного облачного копирования данных – Поставщик должен описать реализацию резервного копирования через удаленный, интернет- или управляемый сервис резервирования. Описание должно содержать клиентскую программу, которая работает по расписанию, и, как правило, собирает, сжимает, шифрует и передает данные на сервер удаленного резервирования. Необходимо также представить более подробную информацию об используемых технологиях.
	О
(обязательно)
	

	10.
	Другие требования по архитектуре
	
	

	10.1
	Архитектура с мобильными решениями – Поставщик должен предоставить реализацию мобильного приложения (детально на техническом проектировании системы).
	О
(обязательно)
	

	11.
	Минимальные требования к серверу безопасности
	
	

	11.1
	· Аппаратное обеспечение сервера (материнская плата, центральный процессор, сетевые карты, системы хранения данных) должно полностью поддерживаться операционной системой Ubuntu 14.04;
· 64-x разрядный Intel dual-core, AMD или совместимый процессор;
· настоятельно рекомендуется наличие поддержки AES инструкций;
· минимум 3 GB оперативной памяти;
· 100 Mbps сетевой интерфейс;
· при необходимости интерфейсы для использования аппаратных токенов;
· Требования к конфигурации: установленная и настроенная операционная система Ubuntu 14.04 LTS x86-64.
	О
(обязательно)
	







10	Приложение Б.	Инструкция по написанию адаптера на С# https://moodle.ria.ee/mod/page/view.php?id=572
Creation of X-Road dataservice and client based on WSDL (.NET platform)
Environment: Windows OP, .NET framework(3.5+), IIS(7+)
https://www.microsoft.com/en-us/download/search.aspx?q=.net%20framework
Tools: MS Visual Studio (2010+) Professional/Ultimate/..,
https://www.visualstudio.com/post-download-vs/?sku=pro&clcid=0x409&telem=ga
SoapUI https://www.soapui.org/downloads/soapui.html
Frameworks: WCF
Method: ‘Top Down’ – generation of C# code based on available WSDL.
[bookmark: _Toc471914691]Preparation
Preparation of the operating environment of the application – Internet Information Services (IIS).
[image: 6]
First check if all necessary Windows components are activated. Otherwise install/add the lacking components. Open by using Control Panel Programs and Features and select Turn Windows features on or off.
Switch on the following components:
· Common HTTP Features
· Directory Browsing and Static Content
As the development of the interfacing component takes place with the ‘Top Down’ method, the WSDL file of the dataservice must be published on the server. By adding this component, we grant to the security server access to static files. This is used by users of the service as well as security server administrators.
· Application Development Features
· .NET Extensibility
·  ASP.NET
X-Road security servers do not transmit SOAPAction header. Therefore, it must be assumed that interfacing components manage incoming SOAP messages by body sub-element. An extension must be added in the WCF framework which enables the same behaviour, SOAPAction header is used by default. A description of the solution to this problem will be provided below.
· .NET Framework Advanced Services
· ASP.NET
· WCF Services
· HTTP Activation
	Note! WCF or ASP.NET services may generate the WSDL
  file automatically if a request is submitted to the address 
http://localhost:port/teenusenimi?wsdl.
However, automatically generated files lack
  obligatory elements of the X-Road namespace. Therefore, the original service
  description file used for generating the code must be published. 


For the realisation of the described steps, the following console command can also be used to install all necessary components.
For the realisation of the described steps, the following console command can also be used to install all necessary components:
	start
  /w pkgmgr /iu:IIS-WebServerRole;IIS-WebServer;IIS-CommonHttpFeatures;IIS-StaticContent;IIS-DefaultDocument;IIS-DirectoryBrowsing;IIS-HttpErrors;IIS-HttpRedirect;IIS-ApplicationDevelopment;IIS-ASPNET;IIS-NetFxExtensibility;IIS-ASP;IIS-CGI;IIS-ISAPIExtensions;IIS-ISAPIFilter;IIS-ServerSideIncludes;IIS-HealthAndDiagnostics;IIS-HttpLogging;IIS-LoggingLibraries;IIS-RequestMonitor;IIS-HttpTracing;IIS-CustomLogging;IIS-ODBCLogging;IIS-Security;IIS-BasicAuthentication;IIS-WindowsAuthentication;IIS-DigestAuthentication;IIS-ClientCertificateMappingAuthentication;IIS-IISCertificateMappingAuthentication;IIS-URLAuthorization;IIS-RequestFiltering;IIS-IPSecurity;IIS-Performance;IIS-HttpCompressionStatic;IIS-HttpCompressionDynamic;IIS-WebServerManagementTools;IIS-ManagementConsole;IIS-ManagementScriptingTools;IIS-ManagementService;IIS-IIS6ManagementCompatibility;IIS-Metabase;IIS-WMICompatibility;IIS-LegacyScripts;IIS-LegacySnapIn;IIS-FTPPublishingService;IIS-FTPServer;IIS-FTPManagement;WAS-WindowsActivationService;WAS-ProcessModel;WAS-NetFxEnvironment;WAS-ConfigurationAPI



[bookmark: _Toc471914692]Creation of X-Road dataservice
Precondition: persons_register.wsdl service description file is completed and WcfExtensions.dll (or its source code from GitHub) is downloaded.
[bookmark: _Toc471914693]Preparation of application
We generate a workspace in Visual Studio, where we start making the application. The first application is an interfacing component of the service provider or Producer, for which we use the WCF Service Application template.
We create a new project and select the required template:
[image: 6]
Delete:
· IService1.cs,
· Service1.svc
· Service1.svc.cs
the files to have a clean application, and add necessary files. For the service description file, we should create a directory with the name ‘wsdl’ and add the previously prepared WSDL file into it.
Create a directory:
[image: 6]
Select the project Producer and challenge the context menu and select Add->New Folder-> folder name: wsdl
Add an extension file:
Select the project Producer and challenge the context menu and select Add->Existing item-> WSDL file.
Add a reference to the .dll file:
References-> in the context menu, Add reference-> in the displayed window Reference Manager, select Assemblies->Browse-> select WcfExtensions.dll file.
	Note! To prevent losing the added file during
  IIS publishing, properties of the file must be changed as follows:
  Build Action->Content
  Copy to Output Directory->Copy always


 
If the application has all components, you can start writing the code. First, it is necessary to create service interface and data model classes. There are several options to do this:
1. Use the programme svcutil.exe on the command line and add the created files to the application. If it is necessary to change the interface code, repeat the operation.
2. Activate the following command on the command line:
	svcutil/l:cs /o:IPersonService.cs /noConfig persons_register.wsdl


/l: - Language, by default CSharp
/o: - Result file name, by default WSDL file name
/noConfig – Configuration file is not required
The last parameter is WSDL file name
Add the result into the project folder
3. Use Visual Studio’s user interface (which in turn uses svcutil.exe).
· Click the References button of the project subdirectory
· In the context menu, select Add service reference
· In the field Address, enter the file name of the service description with a directory name
e.g.: F:\Workspace\NET\XRoad\Samples\Producer\wsdl\persons_register.wsdl
· Enter a suitable name for the namespace of service objects in the field Namespace.
e.g.: pplService
· Click the Advanced button
· Ensure that Allow generation of asynchronous operations check box is not ticked (X-Road does not support asynchronous methods)
· Tick the check box Always generate message contracts
· Click OK
[image: 6]
As a result of this step, pplService folder should be created under the Service Reference directory.
	Note!
In the future, if WSDL file has been changed and data types also need updating,
pplService must be selected in the application in Service Reference directory
and Configure Service Reference ... in context menu, and then select OK.
Thus, svcutil.exe programme is activated and code is created from zero.



[image: 6]
This way, service client code is added to the application, and the first steps are similar when creating a service client application.
Why does a service provider need this? For creating a service interface and classes of objects used in the service.
Created objects can be viewed in Object Browser:
1. Interface of service provider
2. Class of the user of service
3. Objects in the service
4. Objects of service request and X-Road message headers.
	Note!
After adding service reference, the element <client> appears in Web.conf file.
As the service provider does not use it, this can be removed.
<configuration>
…
  <system.serviceModel>
    …
    <client>
      <endpoint address="http://localhost:8080/persons_register/services/person_registerSOAP"
        binding="basicHttpBinding" bindingConfiguration="person_registerSOAP"
        contract="pplService.person_register" name="person_registerSOAP" />
    </client>



[bookmark: _Toc471914694]Implementing the service
Add the file realising the service interface:
In the application context menu, select ‘Add’ -> ‘New Item ...’ -> ‘WCF Service’ -> PeopleRegister.svc (IPeopleRegister.cs file is not necessary and it can be deleted).
	using System;
using Producer.pplService;
 
namespace Producer
{
   
  public class PeopleRegister : pplService.person_register
   
  {
        public personListResponse personList(personListRequest1 request)
        {
            throw new NotImplementedException();
        }
   
  }
}


Add a simple realisation to personList, where headers are copied and a static response is returned:
	public personListResponse personList(personListRequest1 request)
{
   
  return new personListResponse
   
  {
        client = request.client,
        service = request.service,
        id = request.id,
        protocolVersion =
  request.protocolVersion,
        userId = request.userId,
        response = new personListResponseResponse
        {
            person = new person
            {
                birthDate = DateTime.Now,
                firstName = "Juhan",
                lastName = "Tamm",
                personContact = new contact{
                    address = "Metsa 12",
                    email = new []{
                        "juhan@ee.ee"
                    },
                    phone = new []{
                        "333333"
                    }
                }
            }
        }
    };


 
The service can return a simple static response, and in order to change the management method of WCF messages, we add a DispatchByBodyElementBehavior attribute to the class realising the service, which enables to register operations in request administrator list. Each operation must be separately marked with the attribute DispatchBodyElement with two arguments:
personList – name of the root element of a SOAP message (name of service operation)
http://persons_register.x-road.ee – namespace of service provider (same as in WSDL file).
	[DispatchByBodyElementBehavior]
public class PeopleRegister : pplService.person_register
{
   
  [DispatchBodyElement("personList", "http://persons_register.x-road.ee")]
   
  public personListResponse personList(personListRequest1 request)
   
  {
        ...
   
  }
}


Furthermore, a WCF extension must be registered in the Web.Conf file. For changing the configuration file, it is possible to use the interface Microsoft Service Configuration Editor integrated in Visual Studio. Select file Web.config and in the context menu Edit WCF Configuration.
	Note! Before using Type Browser, the application must be compiled. Type Browser parses compiled files to find type classes. Therefore, it may lack recently created classes.


1. Register new extension
1. Select Advanced->Extensions->behavior element extensions->New ...
2. Column Name:CustomMessageFilter.
3. In column Type, select EndpointBehaviorExtension type located in WcfExtensions.dll
2. Create a new service Endpoint Behavior by using a registered extension
1. Select Advanced->Endpoint Behaviors-> New Endpoint Behavior Configuration
2. Name:CustomMessageFilterBehavior
3. In the area Behavior element extension position click Add ...
4. Add CustomMessageFilter element.
3. Register service endpoint
1. Service->Create a New service
2. Service type– click Browse … and select Producer.PeopleRegister type in Producer.dll
3. Next
4. Contract field must be automatically filled.
5. Next
6. Select New binding configuration
7. Communication mode: HTTP
8. Method of interoperability: Basic Web Services interoperability
9. Leave the field Address empty
10. Finish
4. Specify already created Endpoint Behaviour for new service endpoint.
1. Service->Producer.PeopleRegister->Endpoints->(Empty Name)
2. BehaviorConfiguration: CustomMessageFilterBehavior
5. Save the settings
1. File -> Save
After these steps, Web.config file must include the following element:
	  <system.serviceModel>
    <services>
      <service name="Producer.PeopleRegister">
        <endpoint address="" behaviorConfiguration="CustomMessageFilterBehavior"
          binding="basicHttpBinding" bindingConfiguration="" contract="pplService.person_register" />
      </service>
    </services>
    <extensions>
      <behaviorExtensions>
        <add name="CustomMessageFilter" type="WCFExtensions.Helpers.Filters.FilteringEndpointBehaviorExtension,
  WcfExtensions, Version=1.0.0.0, Culture=neutral, PublicKeyToken=null" />
      </behaviorExtensions>
    </extensions>
    <bindings>
      <basicHttpBinding>
        <binding name="person_registerSOAP" />
      </basicHttpBinding>
    </bindings>
    <behaviors>
      <endpointBehaviors>
        <behavior name="CustomMessageFilterBehavior">
          <CustomMessageFilter />
        </behavior>
      </endpointBehaviors>
      <serviceBehaviors>
        <behavior name="">
          <serviceMetadata httpGetEnabled="true" httpsGetEnabled="true" />
          <serviceDebug includeExceptionDetailInFaults="true" />
        </behavior>
      </serviceBehaviors>
    </behaviors>
    <protocolMapping>
        <add binding="basicHttpsBinding" scheme="https" />
    </protocolMapping>    
    <serviceHostingEnvironment aspNetCompatibilityEnabled="true" multipleSiteBindingsEnabled="true" />
 
  </system.serviceModel>


Dataservice is completed. After activating the application, the following view must be displayed:
[image: 6]
Publish service on IIS server
Before using the service it must be placed on a IIS server:
	Note! In order to publish application successfully on a IIS server, it must be activated as a user with administrator rights. 


1. Compile the application
1. Select an application file and in the context menu click Publish. Publish Web window appears.
2. Select Custom and name the profile.
3. Publish method:File System
4. Target location: create and select new directory in IIS application folder e.g.: C:\inetpub\wwwroot\persons
5. Next
6. Configuration: Release
7. Next->Publish
2. Create a new directory on the IIS server.
1. Open IIS Manager
2. In the Sites context menu, select Add Website. A new window appears where directory configuration must be entered
3. Sitename: persons
4. Application Pool: select the pool where .NET framework version is the same/later than the application target framework.
5. Physical path: folder selected in step 1.d
6. IP address: IP address of the local machine
7. OK
After these steps, service should be available from the IIS server of the local machine. (e.g.: http://172.25.200.47/PeopleRegister.svc)
Creation of X-Road client application
Add the new application under the existing solution with which service will be used (using e.g. Console Application template). First, add a reference to our service and generate the client code and the objects of data model. There are several options for doing this:
Use the command line in the programme vcutil.exe and add the resulting files to the application. If the interface code should be changed, the operation must be repeated.
1. Activate the following command on the command line:
	


svcutil /l:cs /o:IPersonService.cs /noConfig persons_register.wsdl
	


/l: – Language, by default Csharp
/o: – Result file name, by default WSDL file name
/noConfig – Configuration file is not required. The last parameter is the WSDL file name
2. Use the Visual Studio user interface.
· Click the References button of the project subdirectory
· In the context menu, select Add service reference.
· In the field Address, enter the URL of the service description file from the local machine e.g.: http://172.25.200.47/wsdl/persons_register.wsdl
Note! Now we contact our local service provider directly. Usually, the dataservice description file from the security server must be used when creating an interfacing component.
	


· Enter a suitable name for the namespace of objects of the service in the field Namespace. e.g.: pplService
· Click the Advanced button
· Ensure that the Allow generation of asynchronous operations check box is not ticked
· Tick the check box Always generate message contracts
· Click OK
Now it is possible to create the object of the client and challenge the service methods. We use the following parameters for challenging the service:
1. Service/xRoadInstance: ee-dev (operate in the X-Road development instance)
2. Service/ memberClass: COM
3. Service/ memberCode: <XRD_MEMBER>
4. Service/ subsystemCode: <TRAINING_PROVIDER_XX>
5. Service/ serviceCode: <name of dataservice>
6. Service/ serviceVersion: <dataservice version no>
7. protocolVersion: 4.0
8. client /xRoadInstance: ee-dev (tegutseme X-tee arendusekeskkonnas)
9. client / memberClass: COM
10. client / memberCode: <XRD_MEMBER>
11. client / subsystemCode: <TRAINING_CONSUMER_XX>

class Program{
    static void Main(string[] args) {
        //Create header objects
        var protocolVersion = "4.0";
        var id = Guid.NewGuid().ToString();
        var userId = "EE37007160274";
        var service = new XRoadServiceIdentifierType {
            xRoadInstance = "ee-dev",
            memberClass = "COM",
            memberCode = "11333578",
            subsystemCode = "aktorstest-db01",
            serviceCode = "personList",
            serviceVersion = "v1",
            objectType = XRoadObjectType.SERVICE
        };
        var client = new XRoadClientIdentifierType {
            xRoadInstance = "ee-dev",
            memberClass = "COM",
            memberCode = "11333578",
            subsystemCode = "misp2-01",
            objectType = XRoadObjectType.SUBSYSTEM
        };
 
        var request = new personList {
            request = new personListRequest {
 
                givenName = "",
                surname = "Tamm"
            }
        };
        //Create client object
        var serviceClient = new pplService.aktorstestPortTypeClient();
 
        //Make service call
        var response = serviceClient.personList(
            client: ref client,
            service: ref service,
            protocolVersion: ref protocolVersion,
            id: ref id,
            userId: ref userId,
            personList1: request);
 
         
    }
 
}


· Пример 1 типовой реализации адаптера на языке программирования JAVA https://github.com/vrk-kpa/xrd4j/tree/master/example-adapter 
· Пример 2 типовой реализации адаптера на языке программирования JAVA https://github.com/petkivim/x-road-test-client
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